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Revision History
The following table lists the revisions of this document.

Revision Change Description

Revision 01 Initial release.

Table 1: Revision History
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About this Guide

This guide describes the steps to install, configure, and deploy the Mobility Master Virtual Appliance or Mobility
Controller Virtual Appliance on:

n vSphere Hypervisor

n Kernel-Based Virtual Machine (KVM) Hypervisor

n Windows Hyper-V

The steps to deploy a Mobility Master Virtual Appliance and Mobility Controller Virtual Appliance as a standby switch
or managed device are the same.

For information related to licensing, refer to the Alcatel-Lucent Mobility Master Licensing Guide.

Important
The following sections of the guide have references to configuration changes that need to be made when
installing a Mobility Controller Virtual Appliance or Mobility Master Virtual Appliance:

n AOS-W VM Requirements

n Assigning Network Connections

Conventions
The following conventions are used throughout this document to emphasize important concepts:

Type Style Description

Italics This style is used to emphasize important terms and to mark the titles of books.

System items This fixed-width font depicts the following:
n Sample screen output
n System prompts
n Filenames, software devices, and specific commands when mentioned in the text

Commands In the command examples, this bold font depicts text that you must type exactly as shown.

<Arguments> In the command examples, italicized text within angle brackets represents items that you
should replace with information appropriate to your specific situation. For example:
# send <text message>
In this example, you would type “send” at the system prompt exactly as shown, followed by
the text of the message you wish to send. Do not type the angle brackets.

[Optional] Command examples enclosed in brackets are optional. Do not type the brackets.

{Item A |

Item B}

In the command examples, items within curled braces and separated by a vertical bar
represent the available choices. Enter only one choice. Do not type the braces or bars.

Table 2: Typographical Conventions

The following informational icons are used throughout this guide:
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Indicates helpful suggestions, pertinent information, and important things to remember.

Indicates a risk of damage to your hardware or loss of data.

Indicates a risk of personal injury or death.

Contacting Support
Table 3: Contact Information

Contact Center Online

Main Site https://www.al-enterprise.com

Support Site https://businessportal2.alcatel-lucent.com

Email ebg_global_supportcenter@al-enterprise.com

Service & Support Contact Center Telephone

North America 1-800-995-2696

Latin America 1-877-919-9526

EMEA +800 00200100 (Toll Free) or +1(650)385-2193

Asia Pacific +65 6240 8484

Worldwide 1-818-878-4507

https://www.al-enterprise.com/
https://businessportal2.alcatel-lucent.com/
mailto:ebg_global_supportcenter@al-enterprise.com
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Chapter 2
Alcatel-Lucent Mobility Master Virtual Appliance

The Alcatel-Lucent Mobility Master Virtual Appliance and Mobility Controller Virtual Appliance provide a 64-bit
virtualized software-based managed platform on virtual machine (VM) architecture. The Alcatel-Lucent Mobility
Master Virtual Appliance and Mobility Controller Virtual Appliance operate on x86 platforms in a hypervisor
environment and can reside with other virtualized appliances. The Alcatel-Lucent Mobility Master Virtual
Appliance and Mobility Controller Virtual Appliance are centralized management platforms for deployment in a
virtualized network infrastructure. Some of the key security features offered by the Alcatel-Lucent Mobility
Master Virtual Appliance and Mobility Controller Virtual Appliance are:

n Authentication

n Encryption Support

n Security Policy

n Rogue Detection and Suppression

n Security Firewall

Listed below are few advantages of switching to Alcatel-Lucent Mobility Master Virtual Appliance or Mobility
Controller Virtual Appliance environment:

n Reduces the number of devices occupying rack space and the overheads associated with managing and
servicing products from different vendors.

n Multiple services are consolidated on a common platform, thereby reducing the cost and optimizing the
infrastructure by providing consolidated services.

n Additional devices can be deployed remotely, increasing hardware selection option and flexibility.

n By eliminating a single point failure, you can create a reliable and high-performance networking system.

On successfully installing the Alcatel-Lucent Mobility Master Virtual Appliance/Mobility Controller Virtual
Appliance, refer to the AOS-W 8.4.0.0 Getting Started Guide for steps to setup the network.

Ensure the number of CPU sockets is always 1 and the value of the cores is the same as the required CPUs.

What's New
This section lists the new features and enhancements released in this version of the installation guide.

AOS-W VM Requirements
Listed below are the minimum resources required for AOS-W VM to function:

If the prescribed vCPU and Memory values are not configured during the initial setup the following error message is
displayed “Minimum 4GB memory (actual 3GB) or minimum 3 CPU (actual 2 CPU) requirement not met”
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SKUs
Total vCPU (hyper
threaded)

Memory (GB) Flash/Disk (GB) Total Supported Interfaces

MM-VA-
50

3 6 6 2 data ports (0/0/0, 0/0/1), 1
mgmt port

MM-VA-
500

6 8 8 2 data ports (0/0/0, 0/0/1), 1
mgmt port

MM-VA-
1K

8 32 32 2 data ports (0/0/0, 0/0/1), 1
mgmt port

MM-VA-
5K

10 64 64 2 data ports (0/0/0, 0/0/1), 1
mgmt port

MM-VA-
10K

16 128 128 2 data ports (0/0/0, 0/0/1), 1
mgmt port

NOTE: Alcatel-Lucent recommends using Intel Xeon E5-2650 v4 @ 2.2GHz enterprise grade CPUs for optimum
performance.

For the Alcatel-Lucent Mobility Master Virtual Appliance and Mobility Controller Virtual Appliance to function as
expected on a VMware ESXi server with NIC teaming, LACP should be configured and enabled between the VMware
ESXi host and upstream switch.

Table 4: Memory and CPU Allocation - Mobility Master Virtual Appliance

SKUs Total vCPU (hyper
threaded)

Memory (GB) Flash/Disk (GB) Total Supported Interfaces

MC-VA-
10

3 4 6 3 data ports (0/0/0, 0/0/1, 0/0/2), 1
mgmt port

MC-VA-
50

4 6 6 3 data ports (0/0/0, 0/0/1, 0/0/2), 1
mgmt port

MC-VA-
250

5 8 8 3 data ports (0/0/0, 0/0/1, 0/0/2), 1
mgmt port

MC-VA-
1K

6 16 16 3 data ports (0/0/0, 0/0/1, 0/0/2), 1
mgmt port

MC-VA-
4K

12 48 48 3 data ports (0/0/0, 0/0/1, 0/0/2), 1
mgmt port

MC-VA-
6K

14 64 64 3 data ports (0/0/0, 0/0/1, 0/0/2), 1
mgmt port

NOTE: Alcatel-Lucent recommends using Intel Xeon E5-2670 v3 @ 2.3GHz enterprise grade CPUs for optimum
performance.

Table 5: Memory and CPU Allocation - Mobility Controller Virtual Appliance

MC-VA-4K and MC-VA-6K are not orderable SKUs. However, you can scale up by installing multiple instances of MC-
VA-1K. For example to deploy 4K APs on a single Mobility Controller Virtual Appliance, you need to add four MC-VA-1K
licenses.



The hypervisor host should not be oversubscribed in terms of number of VMs configured on a host as it
adversely impacts the functionality and performance of AOS-W. In instances where more than one VM is setup
in a hypervisor, then:

n The number of logical processors reported on the hypervisor should be higher or equal to the sum of vCPUs
allocated to each VM setup in that host.

n The sum of the memory allocated to each VM should not exceed the overall host memory capacity
reported.

n The total CPU utilization, memory usage, and network throughput should not exceed 80% of the host
capacity.

Ensure the number of sockets and threads is always one and the value of cores is the same as the current allocation.
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Chapter 3
Installing AOS-W Using vSphere Hypervisor

Prerequisites
Ensure that the following prerequisites are addressed before starting the installation:

n vSphere Hypervisor 5.1, 5.5, 6.0, or 6.5 is installed on the server that hosts the Mobility Master Virtual
Appliance/Mobility Controller Virtual Appliance as a guest.

n vSphere Client/vCenter is installed on a Windows machine.

n OVF/ISO template is obtained from an Alcatel-Lucent representative and accessible from vSphere
Client/vCenter.

Logging Into ESXi Host Using vSphere Client
Follow the steps to log in to the vSphere ESXi Host:

1. Open the vSphere Client.

2. Enter the IP address or name of the vSphere Hypervisor in the IP address / Name field.

3. Enter the user name in theUser name field.

4. Enter the password in the Password field.

5. Click Login.

The vSphere Client page is displayed.

Creating A VM Network For Management
Follow the steps below to create a VM network for management:

1. Log in to the vSphere ESXi Host using vSphere Client. For additional information, see Logging Into ESXi
Host Using vSphere Client.

2. From the vSphere Client page, click Inventory.

3. Click Configuration tab.

4. Click Networking from theHardware menu.

5. Click Add Networking.
TheAdd Network Wizard is displayed.

Figure 1 Adding A Network

6. Select theVirtual Machine radio button and click Next.
7. Select the vSwitch that has VMkernel port mapped for ESXi management network and click Next.
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Figure 2 Selecting A Network Adapter For Management

8. In the Port Group Properties section, provide a name for the management network in theNetwork
Label field and select All (4095) from theVLAN ID (Optional) drop-down list. Click Next.

Figure 3 Selecting Port Group Properties

9. Click Finish.

The VM network name is set to VM Network_Management and is used as an example in all configuration procedures.

10. Click the ESXi host IP address.

11. Click theConfiguration tab.

12. Click Networking from theHardware section.

13. Click Properties of theVM Network_Management.



Figure 4 VM Network Properties_Management

14. Select the VM network that was created for management and click Edit.

Figure 5 Edit Network Properties_Management

15. Click the Security tab.

16. Select the Promiscuous Mode check box select Accept from the drop-down list.

17. Select the Forged Transmits check box and select Accept from the drop-down list.

Forged Transmits should be enabled for VRRP to function.

18. Select theMAC Address Changes check box and select Accept from the drop-down list.

AOS-W 8.4.0.0 Virtual Appliance | Installation Guide Installing AOS-W Using vSphere Hypervisor |  16
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19. Click OK.

20. Click Close.

Creating VM Networks For Traffic
Follow the steps below to create a VM network for traffic:

1. Repeat steps 1 to 4 of Creating A VM Network For Management.

2. Click Add Networking.
TheAdd Network Wizard is displayed.

Figure 6 Adding A Network For Traffic

3. Select theVirtual Machine option and click Next.
4. Select a vSwitch that will handle the network traffic and click Next.

Figure 7 Selecting A Network Adapter For Traffic

5. In the Port Group Properties section, provide a name forNetwork Label and select All (4095) from
theVLAN ID (Optional) drop-down list. Click Next.



Figure 8 Selecting Port Group Properties

6. Click Finish.

Ensure that the Management VM network and the Traffic VM network is isolated to avoid a network loop.

7. Click the ESXi host IP address.

8. Click theConfiguration tab.

9. Click Networking from theHardware section.

10. Click Properties of the vSwitch to edit.

Figure 9 VM Network Properties_Traffic

11. Select the VM network that was created for traffic and click Edit
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Figure 10 Edit Network Properties_Traffic

12. Click the Security tab.

13. Select the Promiscuous Mode check box select Accept from the drop-down list.

14. Select the Forged Transmits check box and select Accept from the drop-down list.

Forged Transmits should be enabled for VRRP to function.

15. Select theMAC Address Changes check box and select Accept from the drop-down list.

16. Click OK.

17. Click Close.

Create two additional networks for traffic and repeat the steps to enable Promiscuous mode and Forged
transmits.

The Mobility Master Virtual Appliance supports three network interfaces and Mobility Controller Virtual Appliance
supports four network interfaces. For more information, see Alcatel-Lucent Mobility Master Virtual Appliance on page
11.

If the vSwitch or Distributed vSwitch is configured to use NIC teaming please refer to the Recommendations
for NIC Teaming on a vSwitch on page 69 in the Appendix for validated configuration settings.

Deploying the OVF Template
Follow the steps below to deploy the Open Virtual Format (OVF) template:

1. Log in to the vSphere ESXi Host using vSphere Client. For additional information, see Logging Into ESXi
Host Using vSphere Client.



2. Click File > Deploy OVF Template.

TheDeploy OVF Template Wizard is displayed.

It is recommended to copy the template to the client machine before importing the OVF template.

3. Click Browse and navigate to the location of the OVA file and click Next.
TheOVF Template Details option is highlighted.

4. Click Next.
TheName and Location option is highlighted..

5. In theName field, enter a name for the OVF template and click Next.
TheDisk Format option is highlighted.

6. Select Thick Provision Lazy Zeroed option and click Next.
TheNetwork Mapping option is highlighted.

7. Select VM Network_Management from theDestination Networks drop-down list and click Next.
TheReady to Complete option is highlighted.

Figure 11 Network Mapping

Review your preferences before clicking Finish.

Do not select Power on after deployment check box in the Ready to Complete window.

8. Click Finish.

The OVF template is deployed.

Since the deployment of the OVF template is time consuming, it is highly recommended that the client is on the same
VLAN as the Mobility Master Virtual Appliance/Mobility Controller Virtual Appliance.
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9. Click OK.

10. Click Close.

Pre-Allocating Memory
Follow the steps below to pre-allocate memory in the Mobility Master Virtual Appliance/Mobility Controller
Virtual Appliance:

1. Right-click the VM and select Edit Settings or click Edit virtual machine settings from theGetting
Started tab.

2. From theResources tab select Memory.
3. Select theReserve all guest memory (All locked) check box.

4. Click OK.

Figure 12 Editing Memory Settings

Repeat the steps to pre-allocate memory for other AOS-W VMs.

For more information on memory and CPU allocation refer to sizing tables in Alcatel-Lucent Mobility Master
Virtual Appliance on page 11.

Assigning Network Connections
By default the management network is assigned to all network adapters.

If different networks are not assigned to different adapters it will result in a network loop.

Follow the steps below to assign different networks to different adapters:

1. Click Edit virtual machine settings.



Figure 13 Virtual Machine Settings

2. Select Network adapter2 and select VM Network_Traffic from theNetwork label drop-down list.

Figure 14 Assigning A Network

3. Repeat the steps and assign:

a. Network adapter3 to VM Network_Traffic1
b. Network adapter4 to VM Network_Traffic2

4. Click OK.
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Adpater Mapping

Network Adapter 1 Out-of-band management

Network Adapter 2 Gigabit ethernet 0/0/0

Network Adapter 3 Gigabit ethernet 0/0/1

Network Adapter 4 Gigabit ethernet 0/0/2

Table 6: Network Adapter Mapping

The Mobility Master Virtual Appliance does not support more than three network interfaces, but Mobility Controller
Virtual Appliance supports four interfaces.

Enabling Security Profile Configuration
This is an optional step and should be used only if serial console redirection is required. To enable security
profile configuration you need to Telnet over the network.

1. Click the ESXi host IP address.

2. Click theConfiguration tab.
3. In the Software section, click Security Profile.

4. In the Firewall section, click Properties.

5. Select theVM serial port connected over network check box.

Figure 15 Enabling VM Serial Port Connected Over Network

6. Click OK.

Configuring Serial Console for the VM
Follow the steps below to configure serial console for the VM:

1. Select the VM machine that was created.

2. Click Edit virtual machine settings.



Figure 16 Edit Virtual Machine Settings

3. On theHardware tab, click Add.

4. Select Serial Port and click Next.
5. Select Connect via Network and click Next.

Figure 17 Configuring Serial Console

6. Select Server (VM Listens for connection) and enter telnet://:6001 in the Port URI field.
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Figure 18 Connecting The Serial Via Network

7. Click Next > Finish > OK.

To enable serial console redirect refer to Configuring the Initial Setup on page 64.

If there are multiple VMs on the same ESXi host ensure they are connected to different serial ports.

To access the VM console you must telnet to the IP address of the ESXi host.
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Chapter 4
Installing AOS-W Using vSphere Hypervisor ESXi 6.5

Prerequisites
Ensure that the following prerequisites are addressed before starting the installation:

n vSphere Hypervisor 6.5 is installed on the server that hosts the Mobility Master Virtual Appliance/Mobility
Controller Virtual Appliance as a guest.

n OVF/ISO template is obtained from an Alcatel-Lucent representative and accessible from vSphere
Client/vCenter.

Support is available for vSphere Web Client from ESXi 6.0 onwards.

Overview of Procedures
Listed below are the steps to install AOS-W using vSphere Hypervisor ESXi 6.5:

n Logging Into ESXi Host Using vSphere 6.5

n Creating a VM Network

n Enabling Serial Console Access

n Configuring Serial Console for the VM

Logging Into ESXi Host Using vSphere Hypervisor 6.5
To log in to the vSphere ESXi host:

1. Enter the IP address of the vSphere Hypervisor in a Web browser.

2. Enter the user name and password.

3. Click Login. The vSphere Web Client page is displayed.

Creating VM Networks

Create two VM networks, one for management and the other for network traffic.

Creating VM Network For Management
To create a VM network for management:

1. Log in to the vSphere 6.5 Web client.

2. Click Networking in theNavigator menu. The networking wizard is displayed.

3. Click Add port group.

4. In Add port group - New port group:

n Enter a name in the for the new port group.

n Enter 4095 in theVLAN ID field.

n Select vSwitch0 from theVirtual switch drop-down list.

5. Click Add.
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6. Select the newly created port group from the networking wizard and click Edit settings.

7. Click the Security tab.

8. Select Accept for Promiscuous mode,MAC address changes, and Forged transmits.

9. Click Save.

Creating VM Networks For Traffic
To create a VM network for traffic:

1. In the vSphere 6.5 Web client navigate to Navigator > Networking. The networking wizard is displayed.

2. Click theVirtual Switches tab.

3. Click Add standard virtual switch.
4. In theAdd standard virtual switch - New switch
n Enter a name in the for the new virtual switch.

n From theUplink1 drop-down list select a vmnic that will handle the network traffic.

5. Click Add.

6. Click Port groups in the networking wizard.

7. Click Add port group.
8. In Add port group - New port group:

n Enter a name in the for the new port group. For example Traffic.

n Enter 4095 in theVLAN ID field.

n Select the virtual switch that was created for traffic.

9. Click the Security tab.

10. Select Accept for Promiscuous mode,MAC address changes, and Forged transmits.

11. Click Add.

Enabling Security Profile Configuration
This is an optional configuration and should be used only if serial console redirection is required. To enable
security profile configuration you need to Telnet over the network.

1. In the vSphere 6.5 Web client navigate to Navigator > Networking.

2. Click the Firewall rules tab.
3. Select VM Serial port connected over network.

4. Click Actions and select Enable.

Configuring Serial Console for the VM
To configure serial console for the VM:

1. In the vSphere 6.5 Web client navigate to Navigator > Virtual Machines. A list of VMs are displayed.

2. Click theVirtual Switches tab.

3. Right click the VM in which you want to configure serial console and click Edit settings.

4. In the Edit standard virtual switch - <virtual switch name> window:

n Click Add other device and select Serial Port.
n Click theNew Serial Port tab and select Use network from the drop-down list.

n Select Server from the drop-down list forDirection.

n Enter telnet://:6001 in Port URL field.



5. Click Save.
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Chapter 5
Installing AOS-W ISO Using vSphere Hypervisor

Logging Into ESXi Host Using vSphere Client
This section describes the configuration of the VM using the vSphere Windows client, if vCenter infrastructure is
available the same can be achieved through the web interface provided by vCenter.

Follow the steps to log in to the vSphere ESXi Host:

1. Open the vSphere Client.

2. Enter the IP address or name of the vSphere Hypervisor in the IP address / Name field.

3. Enter the user name and password in theUser name and Password fields.

4. Click Login. The vSphere Client page is displayed.

Creating a New VM
1. Right click the host IP address and select New Virtual Machine.

2. Select Custom > Next.

Figure 19 Create a New VM

3. Enter a name for the new VM in Name field.

4. Select Storage and click datastore1 as the destination storage. Click Next.
5. Select theVirtual Machine Version 8.

6. Select the Linux radio button forGuest Operating System.

7. Select Red Hat Enterprise Linux 6 (64-bit) from theVersion drop-down menu. Click Next.
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Figure 20 Selecting the Guest Operating System

8. Select the required virtual CPUs from theNumber of cores per virtual socket drop-down list. In this
example, six virtual CPUs are used for 500 devices. For more information see, Alcatel-Lucent Mobility
Master Virtual Appliance on page 11

Figure 21 Selecting Virtual CPUs

9. Select the required memory. In this example 8 GB RAM is used. Click Next.
10. Select the required NICs for the network connections. In this example, 3 NICs are used as the
installation is on the Mobility Master Virtual Appliance, in case of a Mobility Controller Virtual Appliance 4
NICs should be used.

11. Ensure that theConnect at Power On check-box is not selected for NIC 2 and NIC 3. This ensures that
only the management interface comes up on when the OS boots up.



Figure 22 Creating Network Connections

12. Select LSI Logic Parallel as the SCSI controller. Click Next.
13. Select theCreate a new virtual disk radio button an click Next.
14. Create a 4 GB disk space using theDisk field. Click Next.

Figure 23 Create New Disk

15. Select SCSI (0:0) from theVirtual Device Node drop-down list. Click Next.

Adding a Second Disk Virtual Disk and Serial Port
Follow the steps below to create a second virtual disk and a serial port before the installation.

1. Select Edit the virtual machine settings before check box. Click Continue.

2. Click Add in theVirtual Machine Properties page.
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Figure 24 Creating a Second Virtual Disk

3. Select Hard Disk as the device type. Click Next.
4. Create a 16 GB disk space using theDisk field. Click Next. For more information on memory and CPU
allocation refer to sizing tables in Alcatel-Lucent Mobility Master Virtual Appliance on page 11

5. Select SCSI (0:1) from theVirtual Device Node drop-down list. Click Next.
6. Click Finish.

7. Select the VM that was created and click Edit virtual machine settings.

8. Click theOptions tab and click Boot Options.

9. Select the Force BOOT Setup and Failed Boot Recovery check boxes. Click OK.



Figure 25 First Boot Options

Deploying the ISO File
1. Power on the VM. The BIOS setup screen is displayed.

2. In the BIOS setup screen select theBoot tab and select CD-ROM Drive as the first bootable option.
Press F10 to save and exit.
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Figure 26 BIOS Setup Screen

3. Add the ISO file to the local CD drive to enable the VM to select the ISO file from the local CD drive and
start the installation.

4. Power off and power on the VM to continue with the configurations. For more information, see
Configuring the Initial Setup on page 64.
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Chapter 6
Installing AOS-W OVA Using vCenter

Follow the steps below to deploy the Open Virtual Format (OVF) template using vCenter:

1. Login to vCenter.

2. Right-click the ESXi host where the ovf will be deployed and click Deploy OVF Template. This action can
also be done through theActions > Deploy OVF Template.

Figure 27 Deploying the OVF Template

3. Select Local file and click Browse.
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4. Navigate to the location of the ova template, select the file, click Open.

5. Click Next.
6. Provide a name for the VM deployment and select the data center that contains the ESXi host. Click
Next.

Figure 28 Selecting the Name and Location

7. Select the ESXi host to run the deployment. Click Next.
8. Review the details of the deployment and click Next.
9. In the Select storage window ensure Select Thick Provision Lazy Zeroed option and click Next.
10. In the Select networkwindow you can either add a standard vSwitch or distributed vSwitch to the
source network. Click Next and Finish.

Figure 29 Selecting a Network

Adding a Serial Port
Follow the steps below to add a serial port to be configured for serial access.

1. Right-click the ESXi where the OVA is displayed and click Edit Settings.

2. In theVirtual Hardware tab select Serial Port from theNew device drop down and click Add,

3. Make the following changes:

a. ForNew Serial Port select Use Network.

b. ForDirection select Server.
c. For Port URL enter telnet://:<esxi ip address>:<port number>.



4. Click OK and power on the OVA.
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Chapter 7
Installing AOS-W ISO Using vCenter

The following steps summarize the flow of steps to be followed to complete the installation:

1. Download the ISO file.

2. Create a VM running Red Hat Enterprise Linux 6 (64-bit).

3. Edit memory, HDD, network settings, and SCSI controller logic.

4. Edit the VM to force BIOS and use this to change the OS boot from CD.

5. Connect the ISO as CD/DVD from Datastore or local machine.

6. Boot the VM. The VM detects AOS-W from the CD and installs AOS-W.

Create a New VM
1. Download the ISO file from Alcatel-Lucent website and upload the file to the VMware vSphere ESXi
hypervisor datastore.

2. Right-click the ESXi host where the VM will be created and click New Virtual Machine > New Virtual
Machine.

3. In the Select a create type window select Create a new virtual machine.

4. In the Select a name folder window enter a name for the new VM and select a location. Click Next.

Figure 30 Name and Location of New VM

5. In the Select a compute resource window select the location of the host for installation. Click Next.
6. In the Select storage window select the datastore to store the configuration and disk files. Click Next.
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Figure 31 Select Datastore

7. In the Select compatibility window, from the drop-down box select the ESXi version running on the
vSphere. Click Next.
8. In the Select a guest OS screen, select Guest OS Family as Linux and Guest OS version as Red Hat
Enterprise Linux 6 (64-bit). Click Next.

Figure 32 Select Guest Operating System

9. In theCustomize hardware screen make the following changes:

a. Change the CPU value to 6.

Alcatel-Lucent recommends increasing the Cores for CPU and keeping the Socket value always at 1.

b. Click the CPU drop-down and changeCores per Socket to 6.

c. Change theMemory from 2048 MB to 8192 MB.



Figure 33 Customize CPU, Cores Per Socket, and Memory

d. Change theNew SCSI controller type to LSI Logic Parallel.
e. From theNew device drop down select New Hard Disk. Click Add.

f. From theNew device drop down select Network and click Add. Add another network for the
installation.

The following steps for configuring a serial port is optional:

a. From theNew device drop down select Serial Port. Click Add.

b. From theNew Serial Port drop down select Use Network and for Connection changeDirection
to Server.
c. Configure the Port URI to telnet://:<esxi ip address>:<port number>
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Figure 34 Other Modifications

Installing the ISO on the VM
1. Navigate to the ESXi host where the VM was installed.

2. Right click and select Edit Settings.

3. Click theVM Options tab and select Boot Options.

4. Select Force Boot Options and Failed Boot Recovery. Click OK.



Figure 35 Boot Options

5. Click Power on the virtual machine. The BIOS prompt is displayed.

6. In theBoot option changeCD-ROM Drive to first boot option and Hard Drive as the second boot
option. Press F10 to save changes and exit.
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Figure 36 Changes to the First Boot Option

7. Navigate to the ESxi host where the VM was installed. Click the Summary tab.

8. In theVM Hardware section, select CD/DVD drive 1 > Connect to CD/DVD image on a datastore.



Figure 37 Connect the CD/DVD Image on Datastore

9. Browse to the location of the ISO file in the datastore, select the ISO file and click OK. Verify if the
CD/DVD drive is connected in the Summary tab.

The installation will be initiated and once the installation is complete the system will be halted.

Figure 38 System Halt

10. Power off the VM and ensure the ISO is removed from the CD/DVD drive in the Summary tab.
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11. Power on the system.
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Chapter 8
Installing AOS-W Using KVM Hypervisor

Prerequisites
Ensure that the following prerequisites are addressed before starting the installation:

n Enabling Intel VT virtualization hardware extensions in BIOS.

n Installing CentOS 7.2 on the x86 hardware.

Issue the ethtool -K ethX gro off command to ensure generic receive offload is disabled for all Ethernet ports that
are mapped to the AOS-W VM for datapath traffic on KVM Hypervisor as root.

Supported Versions
n QEMU 2.0

The host kernel should be running version 4.6 or above and QEMU verision 2.7.0 for optimum crypto throughput
performance with AOS-W in the KVM infrastructre. Libvrt should support passing of poll-us configuration option from
VM xmlspecification to QEMU.

Enabling Intel VT Virtualization Hardware Extensions in the BIOS
Follow the steps below to enable Intel IT virtualization hardware extensions in the BIOS:

1. Power on the machine and access theBIOS Settings.

2. Navigate to the Processor submenu. Processor settings menu may be hidden in Chipset,Advanced
CPU Configuration, orNorthbridge.

3. Enable Intel Virtualization Technology.

Installing CentOS 7.2
Follow the steps below to install CentOS 7.2 on your system:

1. Connect a DVD or bootable USB stick to install CentOS 7.2.

2. Select Virtualization Host in Software Selection and select allAdd-Ons for the installation.

3. Click Done.

4. Navigate to the location of the CentOS 7.2 file and select the destination folder.

5. Click Begin Installation.

6. Create a new user and a root password for the CentOS 7.2 installation during the installation process.

7. Reboot the server after the installation is complete.

8. Login to the newly installed CentOS 7.2 and configure the network and connect the server to the
Internet.

A connection to the Internet is required to validate the installation and to install other packages.

a) Check for cpu virtualization support by executing the following command:

[root@localhost ~]# cat /proc/cpuinfo | grep -i vmx flags : ……..vmx ……..

b) Check for KVM mode support in the Kernel. If kvm_intel is not listed, manually load kvm_intel using the
modprobe kvm_intel command.

[root@localhost ~]# lsmod | grep -i kvm
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kvm_intel 162153 0

kvm 525259 1 kvm_intel

[root@localhost ~]#

If the Operation not supported error message is displayed, ensure that Intel Virtualization technology is enabled in
the BIOS.

9. Install the following packages:

n yum install qemu-kvm-tools.x86_64 qemu-kvm.x86_64 qemu-kvm-common.x86_64
n yum install virt-manager.noarch virt-manager-common.noarch
n yum install virt-install.noarch
n yum groupinstall "GNOME Desktop"
n yum install tigervnc-server xorg-x11-fonts-Type1

Follow the steps below to install the AOS-W Mobility Master Virtual Appliance or a Mobility Controller Virtual
Appliance on a KVM hypervisor:

1. Configuring the Virtual Network Computing (VNC) Server.

2. Creating a new VM and installing AOS-W.

3. Deploying the Mobility Master Virtual Appliance/Mobility Controller Virtual Appliance.

Configuring the Virtual Network Computing Server
Follow the steps below to configure the Virtual Network Computing (VNC) server and open up the firewall port
to access the server remotely:

1. Start the VNC Server and configure a password for your CentOS server by executing the following
command:
[root@localhost ~]# vncserver.You will require a password to access your desktop.

Password:

Verify:

xauth: file /root/.Xauthority does not exist

New 'localhost.localdomain:1 (root)' desktop is localhost.localdomain:1

Creating default startup script /root/.vnc/xstartup

Starting applications specified in /root/.vnc/xstartup

Log file is /root/.vnc/localhost.localdomain:1.log

2. Open the firewall port on the CentOS server to ensure the CentOS server can be accessed using
vncviewer.
[root@localhost ~]# netstat -ntap | grep vnc

tcp 0 0 0.0.0.0:5901 0.0.0.0:* LISTEN 14318/Xvnc

tcp 0 0 0.0.0.0:5902 0.0.0.0:* LISTEN 5242/Xvnc

tcp 0 0 10.16.9.130:5902 10.20.102.206:51576 ESTABLISHED 5242/Xvnc

tcp6 0 0 :::5901 :::* LISTEN 14318/Xvnc

tcp6 0 0 :::5902 :::* LISTEN 5242/Xvnc

[root@localhost ~]#

[root@localhost ~]# firewall-cmd --permanent --zone=public --add-port=5901/tcp

success

[root@localhost ~]# firewall-cmd --reload

success

[root@localhost ~]#

3. Download the AOS-W ISO image file from support.esd.alcatel-lucent.com to your CentOS server. The
following are examples of ISO image files:

n AOS-W_MM_8.2.0.0_57113.iso.

n AOS-W_VMC_8.2.0.0_57113.iso.



Creating a VM and Installing AOS-W
Follow the steps below to access the CentOS server through the VNC and start the virt manager to create the
VM to be used by AOS-W:

1. Access the terminal and type virt-manager to start theVirtual Machine Manager.
2. Access theVirtual Machine Manager tab.

3. Click on File > New Virtual Machine. TheNew VM dialog box is displayed.

Figure 39 New Virtual Machine

4. Select Choose Local Install Media and click Forward.

5. Select Use ISO image and click Browse.

6. Navigate to the location of the iso image and click Choose Volume.

Ensure that Automatically detect operating system based in install media is not selected.

7. Select OS type as Linux and Version as Redhat Enterprise Linux 7.2 from the drop-down lists and
click Forward.

8. Change theMemory (RAM) to 8192 and CPUs to 6 and click Forward.

For Mobility Controller Virtual Appliance the RAM can be setup as 4096 (4 GB) and 3 CPUs. For more
information on memory and CPU allocation refer to sizing tables in the Alcatel-Lucent Mobility Master Virtual
Appliance on page 11 section.

9. Select Enable Storage for this VM and change the value in Create a disk image on the computer's
hard drive to 4 GB. Click Forward.
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Figure 40 Enabling Storage on the VM

The size of this disk needs to be at least 4 GB for Mobility Master Virtual Appliance/Mobility Controller Virtual
Appliance.

10. Provide a name for the VM and select Customize configuration before install. Click Finish.

Figure 41 Beginning the Installation

11. Select VirtIO Disk 1 and click on Advanced Options and make sure theDisk bus option is VirtIO.



12. Click Add Hardware and add another 8 GB storage device. (should be greater than half the size of RAM
configured for the Mobility Master Virtual Appliance/Mobility Controller Virtual Appliance).

13. Select VirtIO from theBus type drop-down list. Click Finish.

Figure 42 Adding a Second Storage Device

Creating Bridge Entries
Create bridge entries to map all three network adapters that you will create in the steps below:

Ensure that you create a fourth bridge entry when configuring Mobility Controller Virtual Appliance.

1. Login to CentOS and create three bridges and map three physical interfaces to these bridges.
[root@localhost ~]# brctl addbr br1

[root@localhost ~]# brctl addif br1 eno1

[root@localhost ~]# ifconfig br1 up

[root@localhost ~]# brctl addbr br2

[root@localhost ~]# brctl addif br2 eno2

[root@localhost ~]# ifconfig br2 up

[root@localhost ~]# brctl addbr br3

[root@localhost ~]# brctl addif br3 eno3

[root@localhost ~]# ifconfig br3 up

2. To make these bridge entries persistent across reboots, create a file in /etc/sysconfig/network-
scripts/ for all bridges.
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[root@localhost ~]#vi /etc/sysconfig/network-scripts/ifcfg-br1

DEVICE=br1

STP=no

TYPE=Bridge

IPV6INIT=yes

IPV6_AUTOCONF=no

IPV6_DEFROUTE=yes

IPV6_FAILURE_FATAL=no

NAME=br1

UUID=a65be46d-a32a-4dca-bd00-f8acf9a356e5

ONBOOT=yes

IPV6_PRIVACY=no

[root@localhost ~]#

[root@localhost ~]# cat /etc/sysconfig/network-scripts/ifcfg-br2

DEVICE=br2

STP=no

TYPE=Bridge

IPV6INIT=yes

IPV6_AUTOCONF=no

IPV6_DEFROUTE=yes

IPV6_FAILURE_FATAL=no

NAME=br2

UUID=19cf4539-9633-40aa-a4c5-606849b6e3db

ONBOOT=yes

IPV6_PRIVACY=no

[root@localhost ~]#

[root@localhost ~]# cat /etc/sysconfig/network-scripts/ifcfg-br3

DEVICE=br3

STP=no

TYPE=Bridge

IPV6INIT=yes

IPV6_AUTOCONF=no

IPV6_DEFROUTE=yes

IPV6_FAILURE_FATAL=no

NAME=br3

UUID=cb9a8df9-aa37-4346-8993-9e3739a9b0ce

ONBOOT=yes

IPV6_PRIVACY=no

3. Click Network Interface and enter the following values:

n Network Source: Specify shared device name.

n Bridge name: br1

n Device model: virtio



Figure 43 Creating Bridge Entries

4. Click Add Hardware to add two more network interfaces.

5. Map bridge interfaces (br2 and br3) to these network interfaces.

6. Click Add Hardware to add serial console.

Enabling Serial Console Over Telnet
Follow the steps below to enable serial console over telnet. This procedure is optional.

1. Remove the existing Serial 1 device and click Add Hardware.

2. Select Serial on the left pane.

3. Select TCP net Console from theDevice Type drop-down list.

4. Add the CentOS Server IP in theHost field and change the port number.

5. Select theUse Telnet check box and click Finish.
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Figure 44 Enabling Serial Console Over Telnet

6. Execute the following command to ensure the host firewall permits access to port number for serial
console.
[root@localhost ~]# firewall-cmd --permanent --zone=public --add-port=4560/tcp

success

[root@localhost ~]# firewall-cmd --reload

success

Enable serial console redirection from the AOS-W CLI after AOS-W boots up by executing the following command
serial console redirection enable.

7. Select VNC server as the Spice Server from the Type drop-down list.

8. Select Copy local keymap from theKepymap drop-down list and click Apply.

9. Select CPUs and make select theCopy host CPU configuration option.

10. Select theManually set CPU topology option from the Topology drop down list.

11. Ensure the number of Sockets and Threads is always 1 and the value of Cores is the same as the value
of Current allocation.



Figure 45  Configuring CPU Values

12. Click Begin Installation and select Install AOS-W.

Once the installation is complete the system will be halted after configuring the Mobility Master Virtual
Appliance/Mobility Controller Virtual Appliance.

Figure 46 System Halt

13. Force reset the VM to boot AOS-W and access to first boot dialogue.

Important

n Ensure you open the firewall port from CentOS terminal and restart the firewall.

AOS-W 8.4.0.0 Virtual Appliance | Installation Guide Installing AOS-W Using KVM Hypervisor |  54



55 | Installing AOS-W Using KVM Hypervisor AOS-W 8.4.0.0 Virtual Appliance  | Installation Guide

[root@localhost ~]# firewall-cmd --permanent --zone=public --add-port=7001/tcp

success

[root@localhost ~]# firewall-cmd --reload

success

[root@localhost ~]#

Configure Multiple Datapath CPUs
To configure multiple datapath CPU’s additional configuration is required both in host and guest. The guest
changes cannot be made using virt-manager and hence you need to use the virsh edit command.

Ensure that the VM is gracefully shut down by using either the Reboot or Shut Down option before editing the VM xml
specification.

Figure 47 Graceful Shutdown

Changes in Host
On the KVM server, load the vhost_net module
[root@localhost ~]# lsmod | grep vhost

[root@localhost ~]# modprobe vhost_net

[root@localhost ~]# lsmod | grep vhost

vhost_net 18152 0

vhost 33338 1 vhost_net

macvtap 22363 1 vhost_net

tun 27141 3 vhost_net

XML Changes in Guest
Use the virsh edit <name of the VM> command in the KVM server and add the <driver name='vhost'
queues='y'/>” tag, where y = total number of CPU’s allocated to the VM.

For example, for a VM with six VCPU’s and three NIC’s of type Virtio, edit the xml and add <driver
name=’vhost’ queues=’6’> “ tag for each NIC interface.
aruba@ubuntu-server-16x:~$ virsh list --all

Id Name State

----------------------------------------------------

5 centos6.5 running

- vmm-500dev shut off

[root@localhost ~]# virsh edit vmm-500dev

Domain vmm-500dev XML configuration edited.

Add <driver name='vhost' queues='6'/> after “model type=’virtio’” in the bridge config to ensure the
values for the number of queues for the vhost and CPUs for the VM are the same.

The following snippet is an example of multi-queue XML specification for a single NIC interface. The same tag
needs to be added for all Mobility Master Virtual Appliance NIC interfaces.
</controller>



<interface type='bridge'>

<mac address='52:54:00:d3:4a:3c'/>

<source bridge='br1'/>

<target dev='vnet10'/>

<model type='virtio'/>

<driver name='vhost' queues='6'/>

<alias name='net0'/>

<address type='pci' domain='0x0000' bus='0x00' slot='0x03' function='0x0'/>

</interface>

<interface type='bridge'>

<mac address='52:54:00:49:7a:c6'/>

<source bridge='br2'/>

<target dev='vnet11'/>

<model type='virtio'/>

<driver name='vhost' queues='6'/>

<alias name='net1'/>

<address type='pci' domain='0x0000' bus='0x00' slot='0x04' function='0x0'/>

</interface>

<interface type='bridge'>

<mac address='52:54:00:d3:55:7d'/>

<source bridge='br3'/>

<target dev='vnet12'/>

<model type='virtio'/>

<driver name='vhost' queues='6'/>

<alias name='net2'/>

<address type='pci' domain='0x0000' bus='0x00' slot='0x05' function='0x0'/>

</interface>

[root@localhost ~]# virsh edit vmm-500dev

Domain vmm-500dev XML configuration edited.
[root@localhost ~]# virsh dumpxml vmm-500dev | grep queues

<driver name='vhost' queues='6'/>

<driver name='vhost' queues='6'/>

<driver name='vhost' queues='6'/>

[root@localhost ~]#

Reboot the VM and once the VM boots up you should see three CPUs as indicated in the example
(mm) [mynode] #show datapath utilization

Datapath Network Processor Utilization

+------+-----+---------+---------+----------+

| Cpu | Cpu utilization during past |

| Type | Id | 1 Sec 4 Secs 64 Secs |

+------+-----+---------+---------+----------+

SP | 1 | 0% | 0% | 0% |

FP | 2 | 0% | 0% | 0% |

FP | 3 | 0% | 0% | 0% |

Datapath CPU Allocation Summary

Slow Path (SP) : 1, Slow Path Gateway (SPGW) : 0

Fast Path (FP) : 2, Fast Path Gateway (FPGW) : 0

DPI : 0, Crypto (CRYP) : 0

(mm) [mynode] #

VM memory locking xml tag
<name>VMC_50</name>

<uuid>4f5aaac7-7c3c-4565-8bf3-1b1492945cdc</uuid>

<memory unit='KiB'>6291456</memory>

<currentMemory unit='KiB'>6291456</currentMemory>

<memtune>

<hard_limit unit='G'>8</hard_limit>

</memtune>
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<memoryBacking>

<locked/>

</memoryBacking>
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Chapter 9
Installing AOS-W Using Windows Hyper-V

Prerequisites
Ensure that the following prerequisites are addressed before starting the installation:

n Hyper-V Version Windows Server 2012 R2

n Hyper-V Version Windows Server 2016

The following procedure can be used to deploy a Mobility Controller Virtual Appliance or a Mobility Master Virtual
Appliance on Windows Hyper-V.

Installing AOS-W on Windows Server Hyper-V
1. Log into the Windows server.

2. Open the Hyper-V manager.

3. Select the Hyper-V host machine from the navigation pane.

4. Right-click on the host machine and click New > Virtual Machine. Click Next.

Figure 48 Creating a New VM

5. Enter a name for the VM in Specify Name and Location screen. If you want to store the machine in a
location different from the default one, select the Store the virtual machine in a different location
checkbox.

6. Select Generation 1 as generation for this VM. Click Next.
7. Allocate 4096 MB as the startup memory. Click Next.
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8. Click Next on theConfigure Network screen. Network will be configured in later steps.

9. Enter a name for the first virtual disk. A second virtual disk will be added in later steps. Click Next.
10. Select Install an operating system from a bootable CD/DVD-ROM.
11. Select Image file (.iso) and click Browse to navigate to the location of the iso file. Select the iso file and
click Next.
12. Click Finish.

Figure 49 Completing the Installation

Configuring the New VM
1. Right-click on the new VM and click Settings.

2. Select Processor from theHardware pane and set theNumber of virtual processors based on your
requirement. For more information see, Alcatel-Lucent Mobility Master Virtual Appliance on page 11.



Figure 50 Virtual Processor Settings

3. Click IDE Controller 0. Select Hard Drive and click Add to add a second hard drive.

For increased performance it is recommended to use a SCSI controller/Disk instead of IDE controller.

4. Click New.
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Figure 51 Adding a Second Virtual Disk

5. Click Next in theNew Virtual Hard Disk Wizardwindow.

6. Select VHDX as the disk format and click Next.
7. Select Dynamically expanding as the disk type. Click Next.
8. Specify a name and location for the new VM and click Next.
9. The size of the new VM should be at least the size of the RAM. For more information on the size of the
hard disk, see Alcatel-Lucent Mobility Master Virtual Appliance on page 11. Click Next > Finish.

In the Hardware > Processor section of the VM ensure the Maximum number of processors and the Maximum
amount of memory on a single virtual NUMA node in the NUMA topplogy should always be more than the values
configured for the Mobility Master. If the number of processors or memory allocated to the Mobility Master is more
than what is configured under the NUMA configuration, the number of NUMA nodes and sockets will automatically
increase and Mobility Master will not boot up.

Creating a Network Adapter
1. Select Add Hardware from theHardware pane.

2. Select Network Adapter and click Add.

3. Select a virtual switch from the drop-down list.

4. Select Hardware Acceleration and ensure that Enable virtual machine queue and Enable IPsec
task offloading check-boxes are cleared.

5. Select Advanced Features and complete the following steps:



a. Check the Enable MAC address spoofing checkbox.

b. Disable Protected Network.

Figure 52 Advanced Features

6. Click Apply > OK.

Create 3 network adapters for deploying a Mobility Master Virtual Appliance and 4 network adapters for deploying
Mobility Controller Virtual Appliance.

7. Right-click the new VM and click Start.
8. Turn off the VM after the installation is complete and remove the installation ISO from DVD Drive.
Restart the VM.

AOS-W 8.4.0.0 Virtual Appliance | Installation Guide Installing AOS-W Using Windows Hyper-V |  62



63 | Installing AOS-W Using Windows Hyper-V AOS-W 8.4.0.0 Virtual Appliance  | Installation Guide

Figure 53 Restart the VM

To configure remote serial console for the VM, use a third party TCP proxy tool.

Configuring Trunk Ports
Run the following PowerShell commands to configure trunk ports:

n Remove all network adapters from the VM:
Remove-VMNetworkAdapter -vmname VMC

n Add mgmt interface:
Add-VMNetworkAdapter -VMName VMC -Name mgmt

Set-VMNetworkAdapter -VMName VMC -Name mgmt -IPsecOffloadMaximumSecurityAssociation 0 -

VmqWeight 0 -NotMonitoredInCluster $true

n Add data interfaces:
Add-VMNetworkAdapter -VMName VMC -Name p1

Set-VMNetworkAdapter -VMName VMC -Name p1 -IPsecOffloadMaximumSecurityAssociation 0 -

VmqWeight 0 -NotMonitoredInCluster $true -MacAddressSpoofing on

Set-VMNetworkAdapterVlan -VMName VMC -VMNetworkAdapterName p1 -Trunk -AllowedVlanIdList

"1-4094" -NativeVlanId 0

Repeat the commands to create 2 virtual NICs if the device used is a Mobility Master Virtual Appliance or 3 virtual
NICs if the device is a Mobility Controller Virtual Appliance.

These interfaces can then be added to virtual switches added through UI.
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Chapter 10
Post-Installation Procedures

Once the installation is complete, follow these post-installation procedures to complete the deployment.

Configuring the Initial Setup
Follow the steps below to configure initial setup:

1. Click Power on the virtual machine.

2. Enter values for the following first boot parameters in the console:

n System name

n Switch role

n IP type to terminate IPsec tunnel

n Master switch IP address or FQDN

n Is this a VPN concentrator for managed device to reach Master switch

n This device connects to Master switch via VPN concentrator

n Master switch Authentication method

n IPsec Pre-shared Key

n Uplink Vlan ID

n Uplink port

n Uplink port mode

n Native VLAN ID [1]

n Uplink Vlan IP assignment method

n Uplink Vlan Static IP address

n Uplink Vlan Static IP netmask

n IP default gateway

n DNS IP address

n IPV6 address on vlan

n Port-channel

n Port-channel id

n Uplink Vlan Static IPv6 address

n Uplink Vlan interface IPV6 prefix length

n IPv6 default gateway

n Country code

n Time Zone

n Time in UTC

n Date

n Password for admin login

n Re-type password for admin login

The choices you entered in the first boot dialog are displayed.
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Enter a static IP as the management IP in VLAN as part of the Mobility Master Virtual Appliance/Mobility Controller
Virtual Appliance setup. This should be a routable IP in an accessible subnet that the user can use to access the
Mobility Master Virtual Appliance/Mobility Controller Virtual Appliance via CLI (SSH) or Web GUI (HTTP) after
VM setup is complete.

Enter <Ctrl P> to make changes to the first boot parameters.

3. Enter Yes to accept the changes. The Mobility Master Virtual Appliance/Mobility Controller Virtual
Appliance reboots and displays the log in prompt.

4. Log in with user name as admin and the password set in Step 2.

5. Execute the enable command.

6. Power on the Mobility Master Virtual Appliance/Mobility Controller Virtual Appliance and execute the
following command to enable the serial console.

Serial console redirect requires the vSphere Enterprise Plus license. When you enable serial console redirect, the
vSphere console host window will be blank.

(host) #serial console redirect enable

Execute the following command to see the status of the serial console.
(host) #show serial console redirect

Serial Console Redirect : Enabled

Execute the following commands to disable and view the status of the serial console.
(host) #serial console redirect disable

(host) #show serial console redirect

Serial Console Redirect : Disabled

Reboot the Mobility Master Virtual Appliance/Mobility Controller Virtual Appliance to access the serial console after
enabling the serial console redirect.

To access the serial console telnet the IP address of the serial console followed by the serial port configured. For
example: telnet 10.16.12.27 6001.

Management Interface
The Mobility Master Virtual Appliance/Mobility Controller Virtual Appliance is a VM instance and access to the
console is dependent on the deployment environment. If access through the serial port is denied you can
alternatively access the console through the Management Interface. After an IP is assigned, the management
interface can be accessed from anywhere in the network. To implement this change a separate routing table is
assigned with its own default gateway for managing the IP that is introduced. This ensures the management
traffic is routed to the right interface.

The initial implementation of this feature covers IPv4, IPv6, and manual configuration of a static IP for
management interface from the console.

This feature cannot be configured using the WebUI.

Execute the following commands to configure an IP on the management interface:

IPv4:
(host) [mynode] #configure terminal

Enter Configuration commands, one per line. End with CNTL/Z

(host) [mynode] (config) #interface mgmt



(host) [mynode] (config-submode)#no shutdown

(host) [mynode] (config-submode)#ip address 10.16.9.203 255.255.255.0

IPv6:
(host) [mynode] (config) #interface mgmt

(host) [mynode] (config-submode)#ipv6 address 2014::184/64

Execute the following commands to configure a default gateway for the management interface traffic and to
segregate the management traffic from the normal data traffic on datapath ports:

IPv4:
(host) [mynode] (config) #ip default-gateway mgmt 10.16.9.2

IPv6:
(host) [mynode] (config) #ipv6 default-gateway mgmt 2014::1
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Chapter 11
Troubleshooting

Connectivity Issues
Users experience wireless client connectivity issues when Mobility Master Virtual Appliance and Mobility
Controller Virtual Appliance is used with NIC teaming and without configuring LACP. To resolve this issue refer
to in the Appendix.

DHCP Address
Clients connected to the Alcatel-Lucent Mobility Controller Virtual Appliance are unable to get a DHCP address.
This issue is resolved by implementing NIC teaming on vSwitch or Distributed vSwitch. For more information
refer to the Appendix.

ARP Issues

Scenario
ARP issue occurs when Promiscuous Mode is not enabled and all VLANs are disallowed on vSwitch.

Instructions
Enable Promiscuous Mode and allow all VLANs on vSwitch.

To enable Promiscuous Mode, perform the following steps:

1. Log in to vSphere ESXi Host.

2. Switch to Configuration tab.

3. Select Networking underHardware section.

4. Click Properties for a configured vSwitch.

5. Click Edit under Ports tab of vSwitch Properties window.

6. Switch to Security tab in vSwitch Properties window.

7. Select Accept from the Promiscuous Mode drop-down list.

Enable Promiscuous Mode on all ports attached to the VM. If a single port is used in AOS-W, Promiscuous Mode need
not be enabled.

8. Click OK.

To allow all VLANs on vSwitch, perform the following steps:

1. Log in to the vSphere ESXi Host.

2. Click theConfiguration tab.

3. Select Networking underHardware section.

4. Click Properties for a configured vSwitch.

5. Select a configured VM network under Ports tab of vSwitch Properties window.

6. Click Edit under Ports tab of vSwitch Properties window.

7. Select All (4095) from the drop-down list against VLAN ID (Optional).
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8. Click OK.

MAC Address Collision in a Network
A user notices MAC address collision in a network due to duplicate MAC entries. When the duplicate MAC entry
is detected by AOS-W, connectivity to the Mobility Controller Virtual Appliance is lost. To resolve this issue, refer
to the following KB article. Once the issue is resolved reboot all VMs.

https://kb.vmware.com/selfservice/microsites/search.do?language=en_
US&cmd=displayKC&externalId=1024025

Characters Repeating In Remote Console
The user notices unintended keystrokes when typing into a remote console. To resolve this issue, refer to the
following KB article:

http://kb.vmware.com/selfservice/microsites/search.do?language=en_US&cmd=displayKC&externalId=196

Networks Cards Not Detected
When a new network card is added to the ESXi/ESX host the following symptoms might be displayed:

n The new network card is not recognized by the system.

n The new network card is not listed when you run the command esxcfg-nics -l.

To resolve this issue, refer to the following KB article:

http://kb.vmware.com/selfservice/microsites/search.do?language=en_
US&cmd=displayKC&externalId=1034782

HP Proliant DL580 Running ESXi 5.5 Is Not Powered On Due To
Memory Leaks
HP Proliant DL580 running ESXi 5.5 will not be powered on due to memory leaks. To resolve this issue, refer to
the following KB article:

http://kb.vmware.com/selfservice/microsites/search.do?language=en_%20US&cmd=displayKC&externalId=2
085618

Network Interfaces Are Not In The Correct Order
Adding a fifth network adapter that uses vmxnet3 devices changes the PCI bus IDs and also the order of
network interfaces. To resolve this issue, refer to the following KB article:

https://communities.vmware.com/thread/443600

Connectivity Issues Observed When Using Multiple vSwitches
Connectivity issues observed when multiple vSwitches in a VM network. To resolve this issue, refer to the
following KB article:

https://communities.vmware.com/thread/460582

https://kb.vmware.com/selfservice/microsites/search.do?language=en_US&amp;cmd=displayKC&amp;externalId=1024025
https://kb.vmware.com/selfservice/microsites/search.do?language=en_US&amp;cmd=displayKC&amp;externalId=1024025
http://kb.vmware.com/selfservice/microsites/search.do?language=en_US&cmd=displayKC&externalId=196
http://kb.vmware.com/selfservice/microsites/search.do?language=en_US&cmd=displayKC&externalId=1034782
http://kb.vmware.com/selfservice/microsites/search.do?language=en_US&cmd=displayKC&externalId=1034782
http://kb.vmware.com/selfservice/microsites/search.do?language=en_%20US&cmd=displayKC&externalId=2085618
http://kb.vmware.com/selfservice/microsites/search.do?language=en_%20US&cmd=displayKC&externalId=2085618
https://communities.vmware.com/thread/443600
https://communities.vmware.com/thread/460582
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Chapter 12
Appendix

This chapter details additional information required in the current version of the Mobility Master. Click the
following links for more information:

n Recommendations for NIC Teaming on a vSwitch

n Increasing the Flash Size on a vSphere Hypervisor

n Increasing the Flash Size on a KVM Hypervisor

n Backing up and Restoring Critical Data

n Datapath Debug Commands

n Implementing Management Interface

n Upgrading a Controller

n Jumbo Frame Support

Recommendations for NIC Teaming on a vSwitch
When creating a vSwitch on the ESXi host, two or more NICs (network adapters) can be configured in the same
vSwitch. To balance the traffic from the VM host to the uplink device since there is more than one NIC
configured, ESXi provides the following configuration options:

n Route based on originating port ID.

n Route based on IP hash.

n Route based on source MAC hash.

n Explicit failover order.

Configuring NIC Teaming
Login to the vSphere ESXi host using WebUI or a vSphere client. This following example is configured through
the WebUI.

1. Login to the ESXi host.

2. Navigate to Networking > Virtual Switches > Add standard virtual switch or right click
Networking and select Add standard vSwitch.

Figure 54 Adding a Standard Virtual Switch

3. In theAdd standard virtual switch - New switch window enter the following details:

a. vSwitch Name
b. Add the required number of uplinks from theUplink 1 drop-down menu.

c. Under Security, click theAccept radio button for Promiscuous mode and Mac address changes.
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4. Click Add. A new vSwitch is created.

Figure 55 New vSwitch

Creating a Port Group
1. Navigate to Networking > Port groups > Add port group or right click Networking and select Add
port group.

Figure 56 Adding Port Group

2. Provide a name for the new port group.

3. Add the virtual switch that was configured with NIC teaming to this port group.

4. Ensure theAccept radio button is selected for Promiscuous mode,MAC address changes, and
Forged transmits under Security.

5. Click Add. A new port group is created.

Figure 57 New Port Group

Adding the Port Group to a VM Host
To add the port group to an host, edit the host setting of the Mobility Master Virtual Appliance or Mobility
Controller Virtual Appliance.



1. From theNavigator window select Virtual Machines. The list of VMs are displayed.

2. Right-click the VM and select Edit settings or select the VM and click Actions > Edit settings.

Figure 58 Edit VM Settings

3. Add the new port group that was created to the VM host.

Figure 59 Adding Port Group

4. Click Save.
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Preventing Dropping or Looping Broadcast/Multicast Packets
To achieve this you need to make some changes to the NIC teaming policy.

1. From theNavigator window select Networking > Port Groups.

2. Select the new port group that was created and click Edit settings.

Figure 60 Edit Port Group Settings

3. Click Security and select theAccept radio option to enable Promiscuous mode,MAC address
changes, and Forged transmits.

4. Click NIC teaming and make the following changes:

a. Load balancing option to Use explicit failover order.
b. Network failover detection option to Link status only.

c. Select the Yes radio button forNotify switches and Failback.

d. Select No forOverride failover order.



Figure 61 Edit Virtual Switch Settings

5. Click Save.

Configuring ReversePathFwdCheckPromisc

In the WebUI
1. From the Navigator window select Manage > System > Advanced settings.

2. Scroll down or use the search bar to go to theNet.ReversePathFwdCheckPromisc option.

3. Select Net.ReversePathFwdCheckPromisc and click Edit option.

4. In the Edit option -Net.ReversePathFwdCheckPromisc window update theNew value field to 1 and
click Save.

The Net.ReversePathFwdCheckPromisc option is not enabled by default and making changes to this option will be
globally applicable on the ESXi.
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In the CLI
[host:] esxcfg-advcfg /Net/ReversePathFwdCheckPromisc

Value of ReversePathFwdCheckPromisc is 0

[host:] esxcfg-advcfg -s 1 /Net/ReversePathFwdCheckPromisc

Value of ReversePathFwdCheckPromisc is 1
[host:]

If the value of the ReversePathFwdCheckPromisc configuration option is changed when the ESXi instance is running,
you need to enable or re-enable the promiscuous mode for the change in the configuration to take effect.

Creating a Distributed vSwitch Using vCenter with
LACP Configuration
Follow the steps below to create a distributed vSwitch:

1. Log in to the vSphere web client.

2. From theHome screen, select Networking.

Figure 62 Navigating to the Networking Icon

3. Right-click the data center and click Distributed Switch > New Distributed Switch.



Figure 63 New Distributed Switch

4. Enter a name for the new switch in theName and location window. Click Next.
5. Select Distributed switch:6.0.0. Click Next.

Select the exact version that is running on the ESXi host for the distributed switch. In this example we are selecting
Distributed switch:6.0.0, as the setup uses vCenter 6.5 managing ESXi hosts running 6.0.

6. Select the required number of uplink ports Edit Settings page.

Figure 64 Edit Settings

7. Click Next and review your selections.

8. Click Finish.

Adding ESXi Hosts to the Distributed Switch
Follow the steps below to add ESXi hosts to the newly created distributed switch. These steps will enable
vCenter to add physical ports to the distributed switch.

1. Right-click the newly created distributed switch and select Add and Manage Hosts. Click Next.
2. In the Select taskwindow select Add hosts. Click Next.
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Figure 65 Add Hosts

3. Click New Hosts to add new ESXi hosts for the distributed switch configuration.

4. Select the host from the Select new hosts window and click OK.

Select Configure identical network settings on multiple hosts (template mode) to enable similar network
configurations on multiple hosts.

Figure 66 Select New Hosts

5. Click Next. In the Select template host window select a template host to apply its configuration to
other hosts on the switch.

This step will enable you to add physical ports on the ESXi hosts to the distributed switch. Click Next.

6. In theManage physical network adapters window select a physical network adapter.



7. Click Assign uplink. The Select an Uplink for vmnic1 window is displayed.

8. Select Uplink 1 for vmnic1 and click OK. Click Next.

In this example we have selected three uplinks when creating the distributed switch. Repeat these steps for the other
vmnic2 and vmnic3.

9. Click Apply to all to apply the physical network adapter assignments to all hosts on the switch.

Figure 67 Selecting an Uplink for the Physical Adapter

10. Click Next in theManage VMkernel network adapters page.

11. Click Next in theAnalyze impact page and Ready to complete page. Click Finish.

Editing Security Properties on the Distributed Port Group
Follow the steps below to modify the security settings on the distributed port group:

1. Select the distributed port group that is created under the distributed switch.

2. Select theConfigure tab and click Edit.
3. Select Accept from the Promiscuous mode, MAC address changes, and Forged transmits drop
down lists. Click OK.

Figure 68 Modify Security Settings

4. Navigate to Hosts and clusters.
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5. Right-click the AOS-W VM that is running on the ESXi hosts to which the distributed switch is configured
and select Edit Settings.

Figure 69 Mapping Uplink Ports

6. Select the distributed port group that was created in the earlier steps as Network Adapter 2.



Figure 70 Selecting Network Adapter

Connectivity will be restored with correct uplink switch configuration.

Configuring LACP Between the Distributed Switch and Uplink Switch
Follow the steps below to configure LACP between the distributed and uplink switch:

1. From vCenter dashboard, click Networking and select the new distributed switch.

2. Click theConfigure tab, and select LACP.
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Figure 71 Configure LACP

3. Click + to add a LAG.

4. In theNew Link Aggregation Groupwindow update the following and click OK.

a. Name - Name for the new LAG

b. Number of Ports - 3

c. Mode -Active
5. Select the new distributed port group configuration.

By default, uplink ports 1,2, and 3 will be selected for communication as active uplinks. This should be replaced with
the LACP configuration.

6. In the distributed port group page, click theConfigure tab and select Edit.

Figure 72 Edit Port Group Settings

7. Select Teaming and failover.
8. Using the up and down arrow button moveUplink 1,Uplink 2, and Uplink 3 to Unused uplinks and
lag1_MM1_test to Active uplinks. Click OK.



Figure 73 Assigning Uplink Order

Mapping LACP Port with Physical NICs
Follow the steps below to map LACP with physical NICs.

1. Right-click the newly created distributed switch and select Add and Manage Hosts. Click Next.
2. In the Select taskwindow select Manage host networking. Click Next.
3. Click Attached hosts and add ESXi hosts to the LACP configuration. Click Next.

Select Configure identical network settings on multiple hosts (template mode) to enable similar network
configurations on multiple hosts.

Figure 74 Add and Manage Hosts

4. In the Select template host window select a template host to apply its configuration to other hosts on
the switch. Click Next.

This step will enable you to add physical ports on the ESXi hosts for LACP. Click Next.

5. In the Select network adapter tasks window select Manage physical network adapters. Click
Next.
6. In theManage physical network adapters window select a physical network adapter.

7. Click Assign uplink. The Select an Uplink for vmnic1 window is displayed.

8. Select lag_MM1_test0 for vmnic1 and click OK.
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Repeat these steps for the other vmnic2 and vmnic3.

9. Click Apply to all to apply the physical network adapter assignments to all hosts on the switch. Click
Next.

Figure 75 Adding Ports for LACP

10. Click Next in theAnalyze impact screen. There should be no impact in this window.

Increasing the Flash Size on a vSphere Hypervisor
AOS-W enables you to increase the size of your flash to ensure that the flash is hosted on a separate disk. By
doing this you can move to a hard disk with higher storage capacity for flash with minimal impact. Follow the
steps below to increase the size of the flash on the Mobility Master Virtual Appliance.

1. Power down the VM.

2. Right click the VM in the vSphere client and click Edit Settings.

3. Click Add in theVirtual Machine Properties window.



Figure 76 Virtual Machine Properties

4. Click Hard Disk in theAdd Hardware window and click Next.

Figure 77 Selecting the Device Type

5. Select Create a new virtual disk and click Next.
6. Enter a value of the desired disk size and select Thick Provision Lazy Zeroed. Click Next.
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Figure 78 Create Disk

7. Click Next in theAdvanced Options window and click Finish.

Figure 79 New Hard Disk

8. Power on the VM and AOS-W will migrate data from the old hard disk to the new one.



Figure 80 Migrating Data

9. Confirm if the newly added Hard disk 3 is used by AOS-W. TheHard disk 3 will be listed as /dev/sdc1
and if old hard disk is in use, it will be listed as /dev/sdb1. If the OVF file only contains a single hard disk it
be listed as /dev/sda3.

10. If the newHard disk 3 is working as expected, the older hard disk can be removed from the VM and
deleted from disk of the vSphere server.

Figure 81 Removing a Hard Disk

AOS-W supports only 3 disks and the size of the new disk that is added should be more than the current disk size.

Increasing the Flash Size on a KVM Hypervisor
AOS-W enables you to increase the size of your flash to ensure that the flash is hosted on a separate disk. By
doing this you can move to a hard disk with higher storage capacity for flash with minimal impact. Follow the
steps below to increase the size of the flash on the Mobility Master Virtual Appliance.

1. To protect the data on the switch, take a flashback up of AOS-W using scp/ftp/tftp.
(mm) [mynode] #show storage

Filesystem Size Used Available Use% Mounted on
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none 3.0G 5.6M 3.0G 0% /tmp

/dev/vdb1 7.7G 452.7M 6.9G 6% /flash

/dev/vda5 1.4G 380.3M 1022.7M 27% /mnt/disk1

/dev/vda6 1.4G 380.3M 1022.7M 27% /mnt/disk2

(mm) [mynode] #backup flash

Please wait while we take the flash backup.......

File flashbackup.tar.gz created successfully on flash.

Please copy it out of the controller and delete it when done.

(mm) [mynode] # copy flash: flashbackup.tar.gz scp: 10.16.9.107 tester flashbackup.tar.gz

2. Access the virt-manager and right click on the VM. Select Shut Down.

3. Click Shut Down for a graceful shutdown of the VM.

Figure 82 Graceful Shutdown

4. Add a new VirtIO Disk according to your requirement. For more information refer to the sizing table in
Alcatel-Lucent Mobility Master Virtual Appliance on page 11.

5. Double click the VM and click Show virtual hardware details. Click on Add Hardware.

6. In theAdd New Virtual Hardware window click Storage. Enter a desired value for theCreate a disk
image on the computer hard drive option and click Finish. A new disk is added.



Figure 83 Adding New Virtual Hardware

7. Power on the VM. The following message is displayed when AOS-W boots up.

Alcatel-LucentNetworks

AOS-W Version 8.1.0.0 (build 57204 / label #57204)

Built by p4build@lemnos on 2017-04-06 at 20:26:23 PST (gcc version 4.7.2)

(c) Copyright 2017 Hewlett Packard Enterprise Development LP.

[10:18:22]:Starting device manager [ OK ]

Formatting new flash [ OK ]

Forcing filesystem check on new flash [ OK ]

Mounting new flash [ OK ]

Copying files to new flash [ OK ]

8. Once the system boots up, the new disk will show up as vdc and not vdb. The flash will contain the old
data.
(mm) [mynode] #show storage

Filesystem Size Used Available Use% Mounted on

none 3.0G 7.5M 3.0G 0% /tmp

/dev/vdc1 15.6G 477.7M 14.4G 3% /flash

/dev/vda5 1.4G 380.3M 1022.7M 27% /mnt/disk1

/dev/vda6 1.4G 380.3M 1022.7M 27% /mnt/disk2

(mm) [mynode] #

9. Power off the VM and select VirtIO Disk2. Click Remove and reboot the controller.
10. Click Yes in theAre you sure you want to remove this device window.

11. The following information is displayed after rebbot and you will be able to use the new disk.
(mm) [mynode] #show storage

Filesystem Size Used Available Use% Mounted on
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none 3.0G 7.6M 3.0G 0% /tmp

/dev/vdb1 15.6G 477.8M 14.4G 3% /flash

/dev/vda5 1.4G 380.3M 1022.7M 27% /mnt/disk1

/dev/vda6 1.4G 380.3M 1022.7M 27% /mnt/disk2

(ArubaMM) [mynode] #

AOS-W supports only 3 disks and the size of the new disk that is added should be more than the current disk size.

Backing up and Restoring Critical Data
It is important to frequently back up all critical configuration data and files on the compact flash file system to
an external server or mass storage device. Ensure the following files are backed up regularly:

n Configuration data

n WMS database

n Local user database

n Licensing database

n Floor plan JPEGs

n Custom captive portal pages

n x.509 certificates

n switch Logs

Back Up and Restore Compact Flash in the WebUI
The WebUI provides the easiest way to back up and restore the entire compact flash file system. The following
steps describe how to back up and restore the compact flash file system using the WebUI on the Mobility
Master:

1. Click on theConfiguration tab.

2. Click Pending Configuration and then Deploy Changes. Pending Changes is visible only when there
changes to be saved, if this option is not visible skip this step.

3. Navigate to theDiagnostics > Technical Support > Backup Flash page.

4. Click Create Backup to back up the contents of the compact flash file system to the flashbackup.tar.gz
file.

5. Click Copy Backup to copy the file to an external server.

You can later copy the backup file from the external server to the compact flash file system using the file
utility in theDiagnostics > Technical Support > Copy Files page.

6. To restore the backup file to the compact flash file system, navigate to theDiagnostics > Technical
Support > Restore Flash page. Click Restore.

Back Up and Restore Compact Flash in the CLI
The following steps describe the backup and restore procedure for the entire compact flash file system using
the switch’s command line:

1. Enter config mode in the CLI on the switch, and enter the following command:
(host) [mynode] (config) #write memory

2. Use the backup command to back up the contents of the compact flash file system to the
flashbackup.tar.gz file.
(host) [mynode] (config)# backup flash

Please wait while we tar relevant files from flash...

Please wait while we compress the tar file...



Checking for free space on flash...

Copying file to flash...

File flashbackup.tar.gz created successfully on flash.

3. Use the copy command to transfer the backup flash file to an external server or storage device:
(host) [mynode] (config) copy flash: flashbackup.tar.gz ftp: <ftphost> <ftpusername>

<ftpuserpassword> <remote directory>

(host) [mynode] (config) copy flash: flashbackup.tar.gz usb: partition <partition-number>

You can later transfer the backup flash file from the external server or storage device to the compact flash
file system with the copy command:
(host) [mynode] (config) # copy tftp: <tftphost> <filename> flash: flashbackup.tar.gz

(host) [mynode] (config) # copy usb: partition <partition-number> <filename> flash:

flashbackup.tar.gz

4. Use the restore command to untar and extract the flashbackup.tar.gz file to the compact flash file
system:
(host) [mynode] (config) # restore flash

Back Up and Restore Configuration in the CLI
The following steps describe the backup and restore procedure for the configuration file system using the
switch’s command line:

1. Enter config mode in the CLI on the switch, and execute the following command:
(host) [mynode] (config) #write memory

2. Use the backup command to back up the contents of the configuration file system to the
configbackup.tar.gz file.
(host) [mynode] (config) # backup config

Please wait while we take the config backup.......

File configbackup.tar.gz created successfully on flash.

Please copy it out of the controller and delete it when done.

.

3. Use the copy command to transfer the backup configuration file system to an external server or storage
device:
(host) [mynode] (config) copy flash: configbackup.tar.gz ftp: <ftphost> <ftpusername>

<ftpuserpassword> <remote directory>

(host) [mynode] (config) copy flash: configbackup.tar.gz usb: partition <partition-number>

You can later transfer the backup configuration file from the external server or storage device to the
compact flash file system with the copy command:
(host) # copy tftp: <tftphost> <filename> flash: configbackup.tar.gz

(host) # copy usb: partition <partition-number> <filename> flash: configbackup.tar.gz

4. Use the restore command to untar and extract the configbackup.tar.gz file to restore the
configuration:
(host) [mynode] (config) # restore config

Please wait while we restore the config backup........

Config restored successfully.

Please reload (reboot) the controller for the new config to take effect.

Snapshot
A VMware snapshot is a copy of the virtual machine's disk file (VMDK) at a given point in time. Snapshots
provide a change log for the virtual disk and are used to restore a VM to a particular point in time when a failure
or system error occurs.

A snapshot preserves the state and data of a VM at a specific point in time. A VM provides several operations
for creating and managing snapshots and snapshot chains. These operations let you create snapshots, revert
to any snapshot in the chain, and remove snapshots. For additional information about snapshots refer to the
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VMware kb article https://kb.vmware.com/selfservice/microsites/search.do?language=en_
US&cmd=displayKC&externalId=1015180.

Implementing Management Interface
This sections discusses implementation of the management interface on the Mobility Master. It includes the
following:

n Assigning the IP address to the management interface from the CLI

n Ensuring management bound traffic uses the correct interfaces and a default gateway specific to the
management interface

n Protecting the management interface against unwanted traffic and DOS attacks

Once the IP is assigned (manual or dynamic) we should be able to reach the management interface from
anywhere in the network. This requires that we have a default gateway for the management interface. But this
default gateway should not be used for the data routing table of the switch. So the inherent problem is that we
need to have two default gateways; one for the management interface and the other for the data traffic and
the management traffic should be via the management interface only. This is solved by the use of the iproute2
utility and having a separate routing table with its own default gateway for the management IP. With this we
can ensure that the management traffic does not leak onto unwanted interfaces.

The management interface is mapped to eth0 and is a Linux interface. It is not a part of SOS and does not have
access to the SOS firewall to protect itself. Since the management interface is susceptible to attacks it is
imperative that we should firewall this interface. For this we use the iptables firewall present in Linux. We allow
only ssh (22), telnet(2323) ,tftp(69) and HTTPS(443,4343) traffic on the management interface and also rate
limit traffic to protect switch from unwanted traffic flood over the network. Initially phase of this feature is
implemented for manually configuring a static IP for management interface from the console. It covers both
IPv4 and IPv6 implementation. Most of the functional behavior and implementation are same for IPv4 and
IPv6. This feature can be extended for obtaining IP dynamically from DHCP server in the network in future.

Datapath Debug Commands
Listed below are the commands to view the system statistics of your switch:

n Execute the show datapath frame [counters] command to view statistics of the data traffic processed.
This command displays the frame statistics that are received and transmitted from the datapath of the
switch. Allocated frames indicate buffers allocated at any given point of time. A constant increment in the
buffer indicates a buffer leak.

The following example displays statistics of data traffic processed.
(host) #show datapath frame counters

+----+------+-----------------------------------------------------+

|SUM/| | | |

|CPU | Addr | Description Value |

+----+------+-----------------------------------------------------+

| | [00] | Allocated Frames 3155 |

| | [03] | Unknown Unicast 127 |

| | [04] | IPv6 Unknown Unicast 5 |

+----+------+-----------------------------------------------------+

| | | |

| G | [00] | BPDUs Received 28 |

+----+------+-----------------------------------------------------+

https://kb.vmware.com/selfservice/microsites/search.do?language=en_US&cmd=displayKC&externalId=1015180
https://kb.vmware.com/selfservice/microsites/search.do?language=en_US&cmd=displayKC&externalId=1015180


n Execute the show port stats command to view the traffic received/transmitted through gigabit ports
using the datapath.

The following example displays the port statistics.
(host) #show port stats

Port Statistics

---- --------- ---------- ------- -------- --------------- ---------------- --------- -----

---

Port PacketsIn PacketsOut BytesIn BytesOut InputErrorBytes OutputErrorBytes CRCErrors

RxNoMbuf

---- --------- ---------- ------- -------- --------------- ---------------- --------- -----

---

GE 0/0/0 6179766 46516 1192249262 3446810 0 0 0 0

GE 0/0/1 179 166996 14782 5019706 0 0 0 0

GE 0/0/2 0 0 0 0 0 0 0 0

n Execute the show datapath heartbeat stats command to monitor the health of the systems. Heartbeats
are sent from the control plane to the datapath every second. The packets pass through the datapath CPUs
and return to the control plane in one second. If the load on the system increases or there is a CPU lock
there is a possibility of the heartbeat being missed. If this recurs 30 times consecutively the switch reboots.
The heartbeat probe introduced in this release, sends out a probe when two consecutive heartbeats are
missed and also measures the actual time taken for the packets to pass through the datapath CPUs and
return to the control plane.

The following example displays the heartbeat statistics.
(host) #show datapath heartbeat stats

Sibyte HeartBeat Stats:

Total HB sent: 42686

Total HB send errors: 0

Current HB send errors: 0 (max:30)

HB send errors high water-mark: 0

Sibyte Probe Stats:

Total probes sent: 0

Last probe sent @ 0:00:00.000

Last probe rcvd @ 0:00:00.000

n Execute the show datapath dpdk [mempool-stats | ring-stats] command to view the DPDK mempool
and ring statistics. Since the size of the mempool and ring may vary based on the system template this
command identifies the size of the structures used.

The following example displays DPDK mempool and ring statistics.
(host) #show datapath dpdk mempool-stats

DPDK Memory Pool Statistics Table

--------- --------- ----- ------- ---- ------- ------- ----- ----------- ------------ ------------ --------- --------- ----------
mPoolName mPoolAddr Flags phyAddr Size hdrSize eltSize tSize priDataSize success_bulk

success_objs fail_bulk fail_objs cPoolCount

--------- --------- ----- ------- ---- ------- ------- ----- ----------- ------------ -----

------- --------- --------- ----------

log_history 0x2aaaaa802080 0 0x0xa9002080 512 64 2048 0 0 0 0 0 0 479

mbuf_pool 0x2aaa36200000 0 0x0xa9400000 65536 64 4032 0 0 0 0 0 0 62935

msg 0x7fecd6700080 0 0x0x24700080 1024 64 40 24 0 0 0 0 0 1024

(host) #show datapath dpdk ring-stats

DPDK Ring Statistics Table
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---- ---- ---------- -----

Flags: Flag - set for single producer or consumer

Used - number of entries in a ring

Freed - number of free entries in a ring

QThreshold - Enqueque Threshold

nQSuccessBulk - Successful enqueues number

nQSuccessObjs - Objects successfully enqueued

nQFailBulk - Failed enqueues number

nQFailObjs - Objects that failed to be enqueued

dQSuccessBulk - Sucessful dequeues number

dQSuccessObjs - Objects successfully dequeued

dQFailBulk - Failed dequeues number

dQFailObjs - Objects that failed to be dequeued

RingName RingAddr Flag Used Freed QThreshold nQSuccessBulk nQSuccessObjs nQFailBulk

nQFailObjs dQSuccessBulk dQSuccessObjs dQFailBulk dQFailObjs

-------- -------- ---- ----- ----- ---------- ------------- ------------- ---------- ------

---- ------------- ------------- ---------- ----------

MP_log_history 0x2aaaaa800000 0 479 544 0 0 0 0 0 0 0 0 0

MP_mbuf_pool 0x7fecd6600000 0 62908 68163 0 0 0 0 0 0 0 0 0

core-0-low 0x2aaaaa98a5c0 2 0 1023 0 0 0 0 0 0 0 0 0

core-0-high 0x2aaaaa98c640 2 0 1023 0 0 0 0 0 0 0 0 0

core-1-low 0x2aaaaa98e6c0 2 0 1023 0 0 0 0 0 0 0 0 0

core-1-high 0x2aaaaa990740 2 0 1023 0 0 0 0 0 0 0 0 0

core-2-low 0x2aaaaa9927c0 2 0 1023 0 0 0 0 0 0 0 0 0

core-2-high 0x2aaaaa994840 2 0 1023 0 0 0 0 0 0 0 0 0

MP_msg 0x2aaaaa9968c0 0 1024 1023 0 0 0 0 0 0 0 0 0

n Execute the show datapath utilization command to view the CPU utilization of all the datapath CPUs
(SP/FP).

The following example displays datapath CPU utilization statistics.

If the CPU speed is more than 2.1 GHz, data displayed under the 64 Secs option is invalid, but valid only for 1 Sec and
4 Sec options. Counter inconsistency is only for CPUs with speed more than 2.1 GHz.

(host) #show datapath utilization

Datapath Network Processor Utilization

------+---------+---------+----------+

| Cpu utilization during past |

Cpu | 1 Sec 4 Secs 64 Secs |

------+---------+---------+----------+

1 | 0% | 0% | 0% |

2 | 0% | 0% | 0% |

n Execute the show cpuload [current] command to view the switch's CPU load for application and system
processes. Use the current option to check the output of the top two UNIX commands.

The following example shows that the majority of the switch’s CPU resources are not being used by either
the application (user) or system processes.
(host) #show cpuload

user 6.9%, system 7.7%, idle 85.4%



The following example displays the summary of system (CPU) load. When the current option is used, it
displays detailed information of the CPU load for each process.
(host) #show cpuload [current]

top2 - 05:09:29 up 2 days, 9 min, 0 users, load average: 0.00, 0.01, 0.05

Tasks: 132 total, 2 running, 130 sleeping, 0 stopped, 0 zombie

Cpu(s): 2.5%us, 1.5%sy, 0.0%ni, 96.0%id, 0.0%wa, 0.0%hi, 0.0%si, 0.0%st

Mem: 7915932k total, 2817304k used, 5098628k free, 2744k buffers

Swap: 0k total, 0k used, 0k free, 193244k cached

PID USER PR NI VIRT RES SHR S %CPU %MEM TIME+ COMMAND

3462 root 20 0 2134m 16m 7772 S 26 0.2 744:48.18 sos.shumway.elf

3654 root 20 0 56112 5856 4732 S 4 0.1 40:48.87 gsmmgr

3503 root 20 0 0 0 0 R 2 0.0 63:24.05 kni_single

1 root 20 0 8340 676 572 S 0 0.0 0:00.92 init

2 root 20 0 0 0 0 S 0 0.0 0:00.00 kthreadd

3 root 20 0 0 0 0 S 0 0.0 0:00.22 ksoftirqd/0

5 root 20 0 0 0 0 S 0 0.0 0:02.02 kworker/u:0

6 root RT 0 0 0 0 S 0 0.0 0:00.00 migration/0

7 root RT 0 0 0 0 S 0 0.0 0:00.00 migration/1

8 root 20 0 0 0 0 S 0 0.0 0:01.94 kworker/1:0

9 root 20 0 0 0 0 S 0 0.0 0:07.79 ksoftirqd/1

10 root 20 0 0 0 0 S 0 0.0 0:01.26 kworker/0:1

11 root RT 0 0 0 0 S 0 0.0 0:00.00 migration/2

12 root 20 0 0 0 0 S 0 0.0 0:01.08 kworker/2:0

13 root 20 0 0 0 0 S 0 0.0 0:05.80 ksoftirqd/2

14 root 0 -20 0 0 0 S 0 0.0 0:00.00 cpuset

15 root 0 -20 0 0 0 S 0 0.0 0:00.00 khelper

16 root 0 -20 0 0 0 S 0 0.0 0:00.00 netns

...

Upgrading a switch
Follow the steps below to upgrade the switch. You can upgrade the OS on the switch either through WebUI or
through the CLI. The following methods can be used to upgrade the OS on the switch:

n TFTP

n FTP

n SCP

n Local File (This option is available while upgrading through WebUI)

Be sure to back up the switches as described in Backing up and Restoring Critical Data.

In the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > Upgrade > Software
Management.
2. Choose the upgrade method.

3. If you are using TFTP, FTP, or SCP for upgrade enter the server IP address.

4. Enter the image file name.

5. Choose the partition to upgrade.
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6. Select Yes to Reboot Controller After Upgrade.

7. Select Yes to Save Current Configuration Before Reboot.
8. Click Upgrade.

In the CLI:

Execute the following commands on the CLI to upgrade the OS:

For TFTP: (host) [mynode] (config)# copy tftp: <TFTP server IP address> <image file name>

system: partition <0 or 1>

For FTP: (host) [mynode] (config)# copy ftp: <FTP server IP address> <username> <image file

name> system: partition <0 or 1>

For SCP: (host) [mynode] (config)# copy scp: <SCP host IP address> <username> <image file name>

system: partition <0 or 1>

Once the image is uploaded in the flash, save the configuration and reload the switch.

If the following error message is displayed, follow the steps above to reload the OS on both partitions.
(host) [mynode] (config)# show image version

Ancillary image stored on flash is not for this release

*********************************************************************

* WARNING: An additional image upgrade is required to complete the *

* installation of the AP and WebUI files. Please upgrade the boot  *

* partition again and reload the controller.                       *

*********************************************************************

Gracefully Shutting Down AOS-W VMs
It is important to gracefully shutdown the guest AOS-W VM’s to avoid database corruptions and other related
issues. The following steps describe the process to perform a graceful shutdown in the VMware ESXi and KVM
hypervisor.

In the VMware ESXi Hypervisor
1. Right click the VM in the vSphere client.

2. Click Power > Shut Down Guest or Power > Restart Guest.

Figure 84 Graceful Shutdown in VMware ESXi Hypervisor

In the KVM Hypervisor
In the KVM hypervisor peform a graceful shutdown by either clicking click Shut Down orReboot.



Figure 85 Graceful Shutdown in KVM Hypervisor

Jumbo Frame Support
Jumbo frames are the data frames that are larger than 1500 bytes and includes the Layer 2 header and frame
check sequence. Jumbo frames functionality can be configured on the following and can support up to 9216
bytes of payload:

n OmniAccess Mobility Controllers (OAW-40xx Seriesswitches, OAW-4x50 Seriesswitches, and Mobility
Controller Virtual Appliances.

n Mobility Master (Mobility Master Virtual Appliance and hardware Mobility Master)

In centralized deployments, frames that are more than 1500 bytes in size are generated from the AP to the
managed device during encryption and enabling AMSDU. Therefore, whenever the AP associates to the
managed device, jumbo frames are used to get the highest network performance. If this functionality is not
supported, the data frames gets fragmented, which reduces the overall throughput of the network and makes
the network slow.

AOS-W supports jumbo frames between 11ac APs, OAW-40xx Series, OAW-4x50 Series switches, and x86 platforms
such as Mobility Controller Virtual Appliances, Mobility Master (Mobility Master Virtual Appliances, and hardware
Mobility Masters.

Jumbo frames are not supported on Mobility Controller Virtual Appliances and Mobility Master Hardware Appliances
running on Windows Hyper-V.

You can enable the jumbo frame support in the following scenarios:

n Tunnel node: In a tunneled node deployment, the wired clients connected on the tunneled nodes can
send and receive the jumbo frames.

n L2 or L3 GRE tunnels: When you establish a GRE tunnel between two managed devices, the clients on one
managed device can send and receive jumbo frames from the clients on the other managed device on
enabling jumbo frames.

n Between wired clients: In a network where clients connect to the managed device with jumbo frames
enabled ports can send and receive the jumbo frames.

n Wi-Fi tunnel: A Wi-Fi tunnel can support an AMSDU jumbo frame for an AP (the maximum MTU supported
is up to 9216 bytes).

AMSDU is not supported on x86 platforms.
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Limitations for Jumbo Frame Support
This release of AOS-W does not support the jumbo frames for the following scenarios:

n IPsec, IPIP, and xSec.

n IPv6 fragmentation or reassembly.

Configuring Jumbo Frame Support
You can use the CLI to configure the jumbo frame support.

To enable the jumbo frame support globally and to configure the MTU value:
(host) [mynode] (config) #firewall jumbo mtu <1789-9216>

You can configure the MTU value between 1789-9216. The default MTU value is 9216.

To enable jumbo frame support on a port channel:
(host) [mynode] (config) #interface port-channel <id> jumbo

To enable jumbo frame support on a port:
(host) [mynode] (config) #interface gigabitethernet <slot>/<module>/<port> jumbo

Viewing the Jumbo Frame Support Status
Execute the following command to view the global status of the jumbo frame support:
(host-vmc) [mynode] #show firewall

Execute the following command to view the jumbo frame status on a port:
(host-vmc) [mynode] #show interface gigabitethernet <slot>/module>/<port>

Execute the following command to view the jumbo frame status on a port channel:
(host-vmc) [mynode] #show interface port-channel <id>

Enable/disable Jumbo Frame Support Globally and Configure MTU Value
(host) [mynode] (config) #firewall

(host) [mynode] (config-submode)#jumbo ?

mtu MTU of Jumbo frames on this platform (when enabled)

<cr>

(host) [mynode] (config-submode)#jumbo mtu ?

<1789-9216> MTU for Jumbo frames

(host-vmc) [mynode] (config-submode)#jumbo mtu 9216

(host-vmc) [mynode] (config-submode)#no jumbo

Enable/disable Jumbo Frame Support on a Port
(host-vmc) [mynode] (config) #interface gigabitethernet 0/0/0

(host-vmc) [mynode] (config-submode)#jumbo

(host-vmc) [mynode] (config-submode)#no jumbo

Enable/disable Jumbo Frame Support on a Port Channel
(host-vmc) [mynode] (config) #interface port-channel 0

(host-vmc) [mynode] (config-submode)#jumbo

(host-vmc) [mynode] (config-submode)#no jumbo
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